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Emagic Soft- und Hardware GmbH—
Software License Agreement
PLEASE READ THIS SOFTWARE LICENSE AGREEMENT (“LICENSE”) BEFORE USING THE SOFT-
WARE. BY USING THE SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS 
LICENSE. IF YOU ARE ACCESSING THE SOFTWARE ELECTRONICALLY, SIGNIFY YOUR AGREEMENT 
TO BE BOUND BY THE TERMS OF THIS LICENSE BY CLICKING THE “AGREE/ACCEPT” BUTTON. IF 
YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, RETURN THE EMAGIC SOFTWARE TO THE 
PLACE WHERE YOU OBTAINED IT FOR A REFUND OR, IF THE SOFTWARE WAS ACCESSED ELEC-
TRONICALLY, CLICK “DISAGREE/DECLINE”.

IMPORTANT NOTE: To the extent this software may be used to reproduce materials, it is 
licensed to you only for reproduction of materials you are authorized or legally permitted to 
reproduce. 

1. General.  The software, documentation and any fonts accompanying this License 
whether on disk, in read only memory, on any other media or in any other form (collectively 
the “EMAGIC Software”) are licensed, not sold, to you by Emagic Soft-und Hardware GmbH 
(“EMAGIC”) for use only under the terms of this License, and EMAGIC reserves all rights not 
expressly granted to you. The rights granted herein are limited to EMAGIC’s and its licensors’ 
intellectual property rights in the EMAGIC Software and do not include any other patents or 
intellectual property rights. You own the media on which the EMAGIC Software is recorded 
but EMAGIC and/or EMAGIC’s licensor(s) retain ownership of the EMAGIC Software itself. The 
terms of this License will govern any software upgrades provided by EMAGIC that replace 
and/or supplement the original EMAGIC Software product, unless such upgrade is accompa-
nied by a separate license in which case the terms of that license will govern. 

2. Permitted License Uses and Restrictions.  This License allows you to simultaneously 
install the EMAGIC Software on any number of computers which you or your organization 
owns or leases, however, only one copy of the EMAGIC Software may be in use at any given 
time. The EMAGIC Software may be used to reproduce materials so long as such use is lim-
ited to reproduction of non-copyrighted materials, materials in which you own the copy-
right, or materials you are authorized or legally permitted to reproduce You may make 
backup copies of the EMAGIC Software as reasonably necessary in machine-readable form; 
provided that each backup copy includes all copyright or other proprietary notices con-
tained on the original. Except as and only to the extent expressly permitted in this License 
or by applicable law, you may not copy, decompile, reverse engineer, disassemble, modify, 
or create derivative works of the EMAGIC Software or any part thereof. THE EMAGIC SOFT-
WARE IS NOT INTENDED FOR USE IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVI-
GATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL SYSTEMS, LIFE SUPPORT 
MACHINES OR OTHER EQUIPMENT IN WHICH THE FAILURE OF THE EMAGIC SOFTWARE COULD 
LEAD TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE. 
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3. Transfer.  You may not rent, lease, lend or sublicense the EMAGIC Software. You may, how-
ever, make a one-time permanent transfer of all of your license rights to the EMAGIC Soft-
ware to another party, provided that: (a) the transfer must include all of the EMAGIC Soft-
ware, including all its component parts, original media, printed materials and this License; 
(b) you do not retain any copies of the EMAGIC Software, full or partial, including copies 
stored on a computer or other storage device; and (c) the party receiving the EMAGIC Soft-
ware reads and agrees to accept the terms and conditions of this License. 

NFR (Not for Resale) Copies: Notwithstanding other sections of this License, EMAGIC Soft-
ware labeled or otherwise provided to you on a promotional basis may only be used for dem-
onstration, testing and evaluation purposes and may not be resold or transferred.

4. Termination.  This License is effective until terminated. Your rights under this License will 
terminate automatically without notice from EMAGIC if you fail to comply with any term(s) 
of this License. Upon the termination of this License, you shall cease all use of the EMAGIC 
Software and destroy all copies, full or partial, of the EMAGIC Software.

5. Limited Warranty on Media.  EMAGIC warrants the media on which the EMAGIC Software 
is recorded and delivered by EMAGIC to be free from defects in materials and workmanship 
under normal use for a period of ninety (90) days from the date of original retail purchase. 
Your exclusive remedy under this Section shall be, at EMAGIC’s option, a refund of the pur-
chase price of the product containing the EMAGIC Software or replacement of the EMAGIC 
Software which is returned to EMAGIC or an EMAGIC authorized representative with a copy 
of the receipt. THIS LIMITED WARRANTY AND ANY IMPLIED WARRANTIES ON THE MEDIA 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, OF SATIS-
FACTORY QUALITY, AND OF FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO 
NINETY (90) DAYS FROM THE DATE OF ORIGINAL RETAIL PURCHASE. SOME JURISDICTIONS DO 
NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITA-
TION MAY NOT APPLY TO YOU. THE LIMITED WARRANTY SET FORTH HEREIN IS THE ONLY WAR-
RANTY MADE TO YOU AND IS PROVIDED IN LIEU OF ANY OTHER WARRANTIES (IF ANY) CREATED 
BY ANY DOCUMENTATION OR PACKAGING. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY BY JURISDICTION.

6. Disclaimer of Warranties.  YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF THE 
EMAGIC SOFTWARE IS AT YOUR SOLE RISK AND THAT THE ENTIRE RISK AS TO SATISFACTORY 
QUALITY, PERFORMANCE, ACCURACY AND EFFORT IS WITH YOU. EXCEPT FOR THE LIMITED WAR-
RANTY ON MEDIA SET FORTH ABOVE AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICA-
BLE LAW, THE EMAGIC SOFTWARE IS PROVIDED “AS IS”, WITH ALL FAULTS AND WITHOUT WAR-
RANTY OF ANY KIND, AND EMAGIC AND EMAGIC’S LICENSORS (COLLECTIVELY REFERRED TO AS 
“EMAGIC” FOR THE PURPOSES OF SECTIONS 6 AND 7) HEREBY DISCLAIM ALL WARRANTIES AND 
CONDITIONS WITH RESPECT TO THE EMAGIC SOFTWARE, EITHER EXPRESS, IMPLIED OR STATU-
TORY, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES AND/OR CONDITIONS OF 
MERCHANTABILITY, OF SATISFACTORY QUALITY, OF FITNESS FOR A PARTICULAR PURPOSE, OF 
ACCURACY, OF QUIET ENJOYMENT, AND NON-INFRINGEMENT OF THIRD PARTY RIGHTS. EMAGIC 
DOES NOT WARRANT AGAINST INTERFERENCE WITH YOUR ENJOYMENT OF THE EMAGIC SOFT-
WARE, THAT THE FUNCTIONS CONTAINED IN THE EMAGIC SOFTWARE WILL MEET YOUR 
REQUIREMENTS, THAT THE OPERATION OF THE EMAGIC SOFTWARE WILL BE UNINTERRUPTED 
OR ERROR-FREE, OR THAT DEFECTS IN THE EMAGIC SOFTWARE WILL BE CORRECTED. NO ORAL 
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OR WRITTEN INFORMATION OR ADVICE GIVEN BY EMAGIC OR AN EMAGIC AUTHORIZED REPRE-
SENTATIVE SHALL CREATE A WARRANTY. SHOULD THE EMAGIC SOFTWARE PROVE DEFECTIVE, 
YOU ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS ON 
APPLICABLE STATUTORY RIGHTS OF A CONSUMER, SO THE ABOVE EXCLUSION AND LIMITATIONS 
MAY NOT APPLY TO YOU. 

7. Limitation of Liability.  TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT SHALL 
EMAGIC BE LIABLE FOR PERSONAL INJURY, OR ANY INCIDENTAL, SPECIAL, INDIRECT OR CONSE-
QUENTIAL DAMAGES WHATSOEVER, INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF 
PROFITS, LOSS OF DATA, BUSINESS INTERRUPTION OR ANY OTHER COMMERCIAL DAMAGES OR 
LOSSES, ARISING OUT OF OR RELATED TO YOUR USE OR INABILITY TO USE THE EMAGIC SOFT-
WARE, HOWEVER CAUSED, REGARDLESS OF THE THEORY OF LIABILITY (CONTRACT, TORT OR 
OTHERWISE) AND EVEN IF EMAGIC HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
SOME JURISDICTIONS DO NOT ALLOW THE LIMITATION OF LIABILITY FOR PERSONAL INJURY, OR 
OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION MAY NOT APPLY TO YOU. In 
no event shall EMAGIC’s total liability to you for all damages (other than as may be required 
by applicable law in cases involving personal injury) exceed the amount of fifty dollars 
($50.00). The foregoing limitations will apply even if the above stated remedy fails of its 
essential purpose.

8. Export Law Assurances.  You may not use or otherwise export or reexport the EMAGIC 
Software except as authorized by United States law and the laws of the jurisdiction in which 
the EMAGIC Software was obtained. In particular, but without limitation, the EMAGIC Soft-
ware may not be exported or re-exported (a) into (or to a national or resident of) any U.S. 
embargoed countries (currently Cuba, Iran, Iraq, Libya, North Korea, Sudan and Syria), or 
(b) to anyone on the U.S. Treasury Department’s list of Specially Designated Nationals or the 
U.S. Department of Commerce Denied Person’s List or Entity List. By using the EMAGIC Soft-
ware, you represent and warrant that you are not located in, under control of, or a national 
or resident of any such country or on any such list.

9. Government End Users.  The EMAGIC Software and related documentation are “Commer-
cial Items”, as that term is defined at 48 C.F.R. §2.101, consisting of “Commercial Computer 
Software” and “Commercial Computer Software Documentation”, as such terms are used in 
48 C.F.R. §12.212 or 48 C.F.R. §227.7202, as applicable. Consistent with 48 C.F.R. §12.212 or 
48 C.F.R. §227.7202-1 through 227.7202-4, as applicable, the Commercial Computer Soft-
ware and Commercial Computer Software Documentation are being licensed to U.S. Govern-
ment end users (a) only as Commercial Items and (b) with only those rights as are granted 
to all other end users pursuant to the terms and conditions herein. Unpublished-rights 
reserved under the copyright laws of the United States.

10. Controlling Law and Severability.  This License will be governed by the laws of the Fed-
eral Republic of Germany. 
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11. Complete Agreement; Governing Language.  This License constitutes the entire agreement 
between the parties with respect to the use of the EMAGIC Software licensed hereunder and super-
sedes all prior or contemporaneous understandings regarding such subject matter. No amendment to 
or modification of this License will be binding unless in writing and signed by EMAGIC. Any translation 
of this License is done for local requirements and in the event of a dispute between the English and 
any non-English versions, the English version of this License shall govern.

12. MPEG-2 Notice.  To the extent that the EMAGIC Software contains MPEG-2 functionality, the follow-
ing provision applies: ANY USE OF THIS PRODUCT OTHER THAN CONSUMER PERSONAL USE IN ANY MAN-
NER THAT COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR PACKAGED 
MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE PATENTS IN THE MPEG-2 
PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM MPEG LA, L.L.C., 250 STEELE STREET, SUITE 
300, DENVER, COLORADO 80206.
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1 General

1.1 New Way to Set the Dialog 
Language

The Mac OS X version of Logic 6 features a new, Mac OS X compliant, way 
to set the dialog language (the “Display” Preference that was previously 
used has been removed):

•  Select the Logic 6 application in the Finder.

•  Press Ci (to open the Information dialog).

•  Select/Flip open the “Languages” section.

•  Choose the preferred language, and uncheck all other languages.
9
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2 Mixer

2.1 Channel EQ
The Channel EQ of Logic 6 replaces the track EQ which you know from 
older versions of Logic. The new equalizer offers a couple of advantages:

•  improved, extremely high sound quality

•  eight (rather than four) bands

•  expanded range for gain and Q, and a higher frequency resolution 
(even when compared with the Fat EQ)

•  needs less space on the surface of mixer channels

•  better clarity (via thumbnails) for EQ curves

•  variable position in the signal flow (i. e. can also be placed between 
plug-ins)

•  integrated FFT analyzer (pre/post EQ)

•  large graphic display with complete, and intuitive, parameter editing

The integrated precision analyzer (based on Fast Fourier Transformation 
algorithms—FFT) shows the energy (amplitude) of all frequency compo-
nents of the signal. The central display of the Channel EQ fulfills multiple 
display functions: it shows both the curve of the FFT analyzer and the EQ 
curve. An identically scaled frequency axis is shown for both. This allows 
you to easily recognize unwanted frequencies in the analyzer curve, 
while using the EQ to edit them accordingly.

You can switch the analyzer pre or post EQ in order to compare the original 
signal with your edits. You can, of course, also judge the excellent quality 
of the Channel EQ with your ears. We are sure you will be as excited with 
the results as we are!
10
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Using the Channel EQ as the Default
In order to be backwards-compatible with songs created in Logic version 
5 or earlier, the old track EQ is still available. All songs that don’t make use 
of the old track EQ are automatically switched to use the new Channel EQ. 

If your existing Autoload song uses pre-set track EQs, you should modify 
it: Remove the track EQs from all channels. Open Options > Song Settings 
and switch to the Old Songs page. Deactivate the Use pre-Logic 6 track EQ 
checkbox and resave your Autoload song (i. e. replace it). You can now use 
the Channel EQ in all new songs created with Logic 6.

� Please note that the track EQs of older songs are lost by activating 
this option. If you don’t want this to occur, you can use the Channel EQ 
of Logic 6 as a plug-in in older songs. Doing so will, however, be at the 
expense of the Thumbnail view and editing via the EQ page of the 
Logic Control.
11
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� Please note that the Channel EQ has four bands in the Audio version of 
Logic and eight bands in the Gold and Platinum versions. If songs with 
an 8-band EQ from those versions are opened in the Audio version, 
the settings for the additional bands are ignored, but preserved. 
Hence, after being edited in the Audio version, the songs can be 
reopened in the Gold and Platinum versions without any loss of infor-
mation.

2.1.1 Inserting a Channel EQ
The Channel EQ is inserted into the first available insert slot by double-
clicking the EQ area on the upper portion of mixer channel strips. This area 
will change to a thumbnail view of the Channel EQ display. The thumbnails 
provide an overview of the EQ settings used in each individual channel.

O-double-clicking will insert the EQ as the first plug-in and move all 
existing plug-ins of this channel one slot down (and redirecting their 
automation data accordingly, if necessary).

Alternatively, you can insert the Channel EQ in any desired slot as per 
other plug-ins. You’ll find it in the EQ section of the plug-in list. This is the 
only way to insert multiple Channel EQs. (Remember that only the first 
Channel EQ can be displayed as a thumbnail).

2.1.2 Setting EQ Parameters
The Band Type buttons above the display switch individual bands on or 
off.

You can set/adjust the band parameters either directly in the central EQ 
display, or in the parameter area below it. As you move the mouse hori-
zontally over the display, pivot marks for individual bands appear on the 
frequency axis, while the parameter area of the same band is highlighted. 
The following possibilities are available for changing the parameters of a 
band:
12
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•  Move the mouse horizontally over the display until the desired band 
is highlighted. Now click-hold the mouse button on the display back-
ground (not directly on a pivot point): vertical mouse movements 
change the Gain, horizontal movements change the Frequency of this 
band.

•  Click-hold directly on the (illuminated) pivot point of the desired 
band: vertical movements (up/down) change the Q value. The direc-
tion required to increase or decrease the Q value depends on whether 
you are above or below the zero line (this ensures that “up” increases, 
and “down” decreases the volume in this band—you will find this intu-
itively “correct”). Again, horizontal movements (left/right) change the 
Frequency of the band.

•  Click-hold on the desired parameter in the parameter area below the 
graphic display (Frequency, Gain/Slope or Q): Moving up increases, 
and down decreases, the value. In order to prevent accidental 
changes, this is the only way to change the Slope value of the high 
and lowpass filters (bands 1 & 8).

As long as your mouse arrow is in the access area of a band, its individual 
curve will be graphically inserted over the resulting curve of the entire 
equalizer.

� You can also edit Channel EQs via the Logic Control—by pushing the 
EQ button: this will open the first Channel EQ of the selected channel. 
If no Channel EQ is active/available, it will automatically be inserted in 
the first free insert slot.

Parameter Description
The maximum Gain per channel is ±24dB (exception: bands 1 & 8, see 
below), the Frequency ranges from 20Hz to 20.000Hz. The range of Q val-
ues depends on the band. The individual bands are defined as follows:

•  Band 1 is a highpass filter and band 8 is a lowpass filter. The Slope 
parameter can either be 6, 12, 18, 24, 36 or 48 dB/Oct(ave) and Q 
ranges from 0.10 to 100. Q doesn’t affect filters with a 6 dB/Oct slope. 
The maximum Q value without a resonant peak is 0.71.

•  Bands 2 and 7 are shelving equalizers. Their values for Q (steepness 
of their curves) range from 0.10 to 2.00.
13
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•  Bands 3—6 are so called “bell” or “peaking” equalizers. Q can range 
from 0.10 to 100. When set to 100, the equalizers only apply to a very 
narrow band, and can work in a similar fashion to notch filters.

� If Show EQs is activated in the parameter box of a channel, it is 
possible to see a thumbnail view of the Channel EQ displayed in the 
upper corner of a channel strip.

� You can reset all settings of the highlighted EQ band (except 
frequency) by A-clicking in the display area.

� You can reset individual parameters by A-clicking in the parameter 
area.

Master Gain
This fader adjusts the output level of a Channel EQ. This allows you to com-
pensate for level changes introduced by your EQ settings. Master Gain 
has a range of ±24 dB.

Analyzer On/Off
This button allows you to activate/deactivate the FFT analyzer.

� Please note that the FFT analyzer needs additional CPU resources. In 
fact, resource consumption increases significantly at higher resolu-
tions (see below)! We recommend that you disable the analyzer or 
close the Channel EQ window after setting the desired EQ parameters. 
This will free up CPU resources for other tasks.

Analyzer Mode
This flip menu determines the location of the analyzer, either in the Input 
(pre EQ) or Output (post EQ) of the equalizer section.

� The Analyzer pre EQ and Analyzer post EQ options allow you to visu-
ally compare the original and EQ’ed signals.
14
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Analyzer Resolution
This flip menu defines the resolution of the FFT analyzer—or more accu-
rately, the number of frequency bands. This determines not only the pre-
cision of measurements, but also the amount of CPU power needed. The 
options are as follows:

•  Resolution low (1024 points)

•  Resolution medium (2048 points)

•  Resolution high (4096 points)

� Higher resolutions are necessary whenever you need reliable results 
in the area of very low bass frequencies. (The bands derived from FFT 
analysis are divided in accordance with the frequency linear prin-
ciple—non-technically, this means that there are far more bands in 
the highest octave than in the lowest).

dB Warp and Analyzer Top
These two parameters allow you to change the vertical scale of the EQ and 
analyzer curves.

dB Warp allows you to increase the resolution of the EQ Gain parameter in 
the most interesting area around the zero line. Click-holding in the green 
dB scale on the left side of the graphic display, and moving the mouse up 
will increase it (down to decrease). The overall range is always ±30dB, 
but small values will be easier to recognize.

As soon as the Analyzer is activated, you can change the Analyzer Top 
parameter, which alters the scaling of the FFT analyzer, on the right side 
of the graphic display. The visible area represents a dynamic range of 60 
dB, but by click-holding and vertically dragging, you can adjust the maxi-
mum value between +20 dB and −40 dB. The Analyzer display is always 
dB-linear.
15
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2.2 Tape Delay
The additional parameters of the Tape Delay (previously reached via 
001011 button) have been integrated into its graphical user interface. As 
a result, the functionality of these parameters have changed slightly, as 
indicated in the following text.

There is a new Sync button. When the Sync button is engaged, the delay 
is synchronized to the song tempo of Logic 6. In this mode, the plug-in 
uses the internal tempo of Logic Platinum to determine the delay time. 
The sole purpose of the Tempo box is to display the current bpm value. 
This is as per the use of the Tape Delay in the past. 

Disengage Sync if you would like to adjust the delay time independently 
of the song tempo (or change the song tempo without changing the delay 
time). In this mode, the bpm value or ms values can be altered freely by 
click-holding in the Tempo or Delay (time) parameter fields while dragging 
up or down with the mouse. Note that click-dragging on the left-hand side 
of Delay field will increment the ms values in large steps. Click-dragging 
on the right-hand portion of the field will increment the ms values in small 
steps. Delay time is adjustable between 0 and 1260 ms.

The Freeze parameter captures the current delay repeats, and sustains 
them until the Freeze parameter is released.
16
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The Tape Delay includes an LFO for delay time modulation. Use it to pro-
duce chorus-like effects—even with long delays. The LFO offers adjust-
able Speed and Depth controls.

Flutter simulates the tape speed irregularities of the tape transports 
found in analog tape delay machines, and is adjustable in Rate and Inten-
sity.

Smooth determines how quickly the “analog tape” can change its speed 
when switching between different note values. It also evens out the 
effect of LFO modulation and tape flutter. Pitch changes caused by the 
use of LFO modulation or Flutter will sound less pronounced when the 
Smooth value is increased.

2.3 Groups
Logic 6 introduces Groups. A Group allows you to combine multiple chan-
nel strips in order to link their volume faders and mute buttons. If, for 
example, multiple audio tracks (with individual choir voices) are assigned 
to one Group, changing the volume of one choir track changes the vol-
umes of all choir tracks. Individual level relationships—at the time the 
channels assigned to the Group—are retained. 

Groups can also link the selection of objects in the Arrange window, 
thereby linking all edit operations you perform on grouped tracks. 

Up to 32 Groups can be created. Each channel can be a member of multi-
ple Groups.

2.3.1 Assigning a Channel to a Group
There is a new Group display in the channel—above the automation mode 
display. Clicking on the Group display opens the Group flip menu where 
one of the 32 Groups can be chosen, turned “off”, or the “Group Settings 
…” dialog window launched.
17
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Overlapping Groups
One channel can belong to more than one group. To assign an additional 
group to a channel, press S while choosing a Group via the Group flip 
menu.

Fast Assignment
Groups can be quickly set and cleared by holding O when clicking on the 
Group display. The last Group setting—also overlapping groups—will be 
applied to the current channel, without opening the flip menu.

2.3.2 Group Settings
The Group flip menu (of the Group display) also allows you to open the 
“Group Settings …”. In the group setting dialog, the following options can 
be set for each individual group:

Name
You can name each group.

Enable
A group can be completely disabled here.

Arrange Selection (Edit)
Selecting an arrange object on one member track of a group selects the 
same horizontal range of all member tracks. 

Arrange Track Zoom
Zooming an individual track of a group will zoom all members.

Arrange Track Hide
Hiding an individual track of a group will hide all members.

Arrange Track Record
Record enable/disable of an individual track of a group will record enable/
disable all members.

Automation Mode
Changing the automation mode of an individual track of a group will 
change the automation mode for all members.
18
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Instrument Color
Changing the color of one group member channel will assign this color to 
all group member channels.

Volume
Changing the volume fader of one group member channel will change the 
volume of all member channels—while maintaining the level relation-
ships between them. If possible, use a volume fader with a high initial set-
ting

Mute
The Mute status of all member channels is synchronized.

2.3.3 Group Automation
For mix automation, any Group member can act as a “master”. When an 
automation parameter value is written, the corresponding value of all 
other Group members is also written, depending on their Automation 
mode (e. g. Touch or Latch). The data is written individually for each chan-
nel. As a result, you can disable the Group later, without affecting the auto-
mation of any Group member—and can obviously edit or change chan-
nels individually.

2.3.4 Temporarily Disable a Group (Clutch)
It is possible to temporarily disable all Group parameter links—e. g. in 
order to change the volume of an individual channel, even if it is member 
of a Group with linked volumes. To do so, simply use the Toggle Group 
Clutch Key Command (default g). As long as the Clutch is active, all 
Group displays will change color—from yellow (normal) to blue (Clutch 
active, all Groups temporarily disabled).
19
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2.3.5 Group Handling on the Logic Control
Click-holding the GROUP button allows you to use the SELECT buttons to 
assign the selected channels to the next free (new) group. You can use 
the BANK switches during this operation.

While in the Group mode (click and release the GROUP button), you can 
switch between Groups with I and M. The Group number (G1—G9, 10—
32) is displayed in the 7-segment ASSIGNMENT display; the first charac-
ters of the Group name are displayed in the SMPTE/BAR display.

The LC-Display shows the track names in the top line. The bottom line will 
indicate the Group properties of the selected Group. J and K switch to 
further pages of Group properties. The SELECT keys display/edit the 
assignment of their channel to the currently selected Group.

TRACK+GROUP activates a Track Multi Channel View mode, which allows 
you to assign each channel to any Group (or turn it “off”) via each chan-
nel’s V-Pot. Alternatively, you can enter this mode by pressing TRACK and 
then J or K until you reach the “Group” page.

2.3.6 Supported Control Surfaces
Logic supports various Control Surfaces besides the Logic Control. More 
information about Control Surfaces can be found in the folder “Control Sur-
faces Info” in the section “Service” of your Emagic Software CD. Here‘s an 
overview over the supported devices.

•  CM Labs Motormix

•  Emagic Logic Control, Logic Control XT

•  Radikal Technologies SAC-2K, SAC 2.2

•  Roland SI-24

•  Tascam US-224, US-428
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2.4 Automation Quick Access
This new feature makes Track Automation extremely fast and simple if 
you only have one hardware MIDI controller available (e. g. one fader on 
your MIDI keyboard or even just the Modulation wheel). You can use this 
single hardware controller to access the currently visible Automation 
parameter of the selected Track in the Arrange window.

2.4.1 Setting Up Automation Quick Access
Open the Automation Settings dialog: Options > Track Automation > Track 
Automation Settings…

There is a new section labeled: Automation Quick Access which can be 
enabled or disabled via a checkbox. Once enabled, click the Learn Mes-
sage button below, and move the hardware controller that you’d like to 
use for Automation Quick Access. The other parameters shown here will 
immediately identify and indicate the type of control element you are 
using (even quite exotic formats are supported). Disable the Learn Mes-
sage button, by clicking on it a second time, or close the Automation 
Quick Acess dialog.

Once done, you will have hardware control over any currently visible Auto-
mation parameter which is set in the current Arrange track.

Enable/Disable Automation Quick Access
In case you are using the Modulation Wheel for Automation Quick Access 
(AQA), you might want to switch between using it for AQA and “normal” 
Modulation Wheel duties—as MIDI controller #1.

This can be done with the global Toggle Automation Quick Access Key 
Command. 
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2.5 New Options for Digital Mixdown/
Bounce

The Bounce function allows you to write the signal of an Output object as 
an audio file, which would otherwise simply be played live. You can initiate 
the Bounce process(es) by clicking the “BNCE” button on the Output 
object channel that you would like to bounce.

The bounce dialog of Logic 6 has been restructured, and offers a couple of 
new options…

2.5.1 Bouncing MP3 Format Audio Files
Logic 6 for Mac OS X now allows the bouncing of MP3 (or by its correct 
name: MPEG-2-Layer-3) format files. This well-known data reduction for-
mat for digital audio signals was developed by the Fraunhofer Institute, 
and allows high compression rates while maintaining quite good audio 
quality (depending on the compression rate). MP3 is the current stan-
dard for audio file exchange via the Internet.

� Due to the fact that encoding an MP3 file equates to a loss of audio 
quality, you should not use MP3 files during a production if you have 
access to the same audio data in linear formats such as: AIFF, WAV or 
SDII.

If you set the File Format flip menu in the bounce dialog to MP3, you will 
see all available options for the encoder (which translates the PCM linear 
format into compressed MP3 files).
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� You can change the default settings for the encoding engine via the 
Preferences > MP3 Export menu.

For details on the individual MP3 encoding parameters see the MP3 
Export Settings section, on page 40 of this addendum.
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2.5.2 Bounce Mode
The new Bounce dialog option Bounce Mode is available in Logic 6 for Mac 
OS X and Mac OS 9.

In older versions of Logic, bounces were always performed in real-time. 
The new Bounce Mode parameter allows you choose between two 
options:

•  Realtime: Creates the bounce file in real-time, as in older versions. 
Use it whenever you wish to bounce audio and audio instrument 
tracks plus external MIDI sound sources that are routed into the Logic 
Mixer via (Live) Input objects.

•  Offline: Accelerates the bounce process—depending on the complex-
ity of your arrangement and available CPU processing power. It also 
allows the bouncing of complex arrangements that would normally 
exceed the power of your CPU, if trying to play them in realtime. Offline 
bouncing, however, is limited to internal sources (audio tracks or 
audio instrument tracks). The MIDI tracks and Input Objects of Logic’s 
mixer are deactivated during offline bouncing.
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� Please note that the Offline Bounce Mode is only available to the 
Output objects of mixers that belong to native audio driver systems. 
DSP-based audio hardware (e. g. ProTools) can not make use of offline 
bouncing due to the nature of its stream-oriented technology.

� Other software applications, which are fed into your Logic Mixer via 
ReWire technology are available for offline bounce processes!

During an Offline Bounce, you can see the SPL moving through the song 
(usually much faster than real-time). A separate “bounce” progress bar is 
also shown.

Unlike online (realtime) bouncing, audio outputs will be muted during 
offline bouncing.
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3 Arrange Window

3.1 Freeze
Logic 6 introduces a completely new way to save almost 100% of the CPU 
power used for software instruments and effect plug-ins—namely, the 
innovative Freeze function. You can apply it, individually, to audio tracks 
or audio instrument tracks. 

3.1.1 Concept
Internally, Freeze performs individual offline bounce processes for each 
“frozen” track. All plug-ins of a track (including software instrument plug-
ins, if applicable, along with all related automation data) are rendered into 
a “freeze file”.

As long as a track is frozen—following the freeze process—this freeze file 
will play back in place of the original track (and its CPU-hungry plug-ins). 
The original track and plug-ins are temporarily deactivated, and use no 
CPU resources.

� Please note that the Freeze function always bounces all of a 
channel’s signals. If you are using more than one track that 
addresses the same audio or instrument channel, then all tracks of 
this channel will be frozen, and cannot be edited independently.

� Due to technical reasons, the Freeze function is not available for the 
tracks of DSP-based audio hardware systems (e. g. ProTools), tracks 
that use plug-ins which are calculated on DSP cards (Powercore, 
UAD-1, Pulsar etc.), or tracks that use external signal processing 
devices via the I/O plug-in. You can, however, “freeze” tracks that use 
Sends to Busses that have inserted DSP-based or I/O plug-ins.
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3.1.2 Application
In real-world situations, Freeze allows you to:

•  use additional plug-ins or software instruments in further audio or 
instrument tracks, which would normally not be possible as it would 
exceed the CPU processing limits of your computer.

•  play back songs created on computers with greater CPU power.

Freeze was made for very CPU-intensive processes, which are generally 
(from higher to lower demand) outlined as follows:

•  Software synthesizers with a complex voice architecture

•  Plug-ins with a complex structure (e. g. reverbs, filter banks or FFT-
based effects)

•  Software synthesizers with a simple voice architecture

•  Software sampler with active filter

•  Software sampler with deactivated filter

•  Plug-ins with a simple structure

As long as your computer is able to calculate all active processes in real-
time, it is not necessary to freeze a track.

Freeze is recommended whenever your system’s power runs short and 
one, or multiple, existing tracks with CPU-intensive instrument and/or 
effect plug-ins are in a final state, or at least seem to require no further 
changes for the meantime—i. e. “close to final”.

As long as a track is frozen, its CPU usage is reduced to that of a high res-
olution audio track, without any effect plug-ins inserted—regardless of 
the number, or processing demands, of the plug-ins that were used origi-
nally.
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3.1.3 How to Freeze a Track
It is extremely easy to freeze a track: simply activate the Freeze button—
i. e. the button that features a small ice crystal icon. If the Freeze buttons 
are not visible, activate the View > Track Freeze Switch menu option in the 
Arrange window.

The Freeze button of the “Audio 1” track

Logic will create freeze files after receiving the next “Play” command. This 
allows you to activate the Freeze buttons of multiple tracks, and render 
their freeze files in one go.

During the Freeze process, the SPL will follow the currently rendered posi-
tion. A floating progress bar window is also displayed.

� Freeze files are always rendered between the song start and end 
mark—it is recommended that you check the song end mark in the 
bar ruler before starting a Freeze process. Please note that the end 
mark should be adjusted to include feedback-dependent delay repeti-
tions or reverb tails. Empty areas (digital zero) at the end of freeze 
files will automatically be removed after the Freeze process.

� You can abort freeze processes by pressing C.—in this scenario, 
the portion of the frozen track(s) that has already been rendered will 
remain in the freeze file(s), and will be used for playback. Frozen 
tracks will remain silent beyond this point.

� The freeze process uses 100% of available CPU power. If, for example, 
a track uses 40% of the CPU, its freeze file will be created in 2.5 times 
the realtime speed. If the original tracks uses 100% of the CPU power, 
the freeze process will happen in (approx.) real-time—even if offline 
bouncing is used.
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Working with Frozen Tracks
Once a track has been frozen, you cannot edit any instrument or plug-in 
parameters (or related automation data). You can, however, still edit the:

•  effect send levels and destinations,

•  panorama and surround parameters,

•  volume, mute and solo

of frozen tracks—including their automation data.

Whenever you try to edit “forbidden” parameters of frozen tracks, (e. g. 
plug-in parameters that were rendered into the freeze file), Logic will dis-
play an error message.

Error message if you attempt to edit a frozen track

In this situation:

•  deactivate the Freeze button of the track,

•  This will delete the freeze file. 

� Please note that the track will now use the amount of CPU processing 
power that it originally required, if you enter “Play” mode.

•  perform your edits,

•  activate the Freeze button again, if required.

It is not possible to cut and re-arrange the freeze files in any way, nor is it 
possible to mix the freeze files with their originals on a single track—you 
can use one or the other, not both!

It is also not possible to record audio on frozen tracks. In fact, the Record 
button will be hidden while a track is frozen.
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3.1.4 Freeze Files
The temporary freeze files are saved in a folder named “Freeze Files” 
which is created in the root directory of your song (e. g. the project 
folder). Usually, you won’t need to access these freeze files directly.

Logic manages these freeze files for you automatically in the back-
ground: They are created during the Freeze process, will play back in 
place of the original tracks (as long as these tracks are frozen), and will 
be deleted as soon as the Freeze button of the corresponding track is 
deactivated.

In some cases, however, it might be handy to use freeze files directly: e. g. 
if you want to freeze all of your tracks, and use the freeze files for a remix 
in another studio (on DSP-based systems, for example).
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3.2 Arrange Channel Strip
In Logic 6, the Channel Strip of 
the currently selected Arrange 
track will appear in the parame-
ter area of the Arrange window, 
provided that there is sufficient 
space to display it. If there is not 
enough vertical room, click the 
upper left triangles in the 
Sequence Parameter and/or 
Instrument Parameter Boxes 
and/or hide the Toolbox (View > 
Toolbox). The Arrange Channel 
Strip allows you to access all of 
the mixer channel functions 
(volume, pan, sends, inserts, 
etc) directly from the Arrange 
window. Any adjustments you 
make to a track’s Arrange Chan-
nel Strip will be reflected in the 
corresponding Track Mixer and 
Environment Channel Strip as 
well.
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3.3 Sample-accurate Waveform 
Display

The Arrange window now displays 
the actual waveform of an audio 
file, all the way down to single sam-
ple resolution at the highest zoom 
levels. The new Waveform vertical 
zoom Key Commands make this 
feature even more useful; for pre-
cise Arrange edit operations, and 
for operations on audio regions 
with low signal levels.

3.4 The Marquee Tool
Logic 6 introduces a new tool to the Arrange window’s toolbox: 
the Tool, which looks like a crosshair. This tool can also be 
selected via the Set Marquee Tool Key Command. You can use 

the Marquee tool by click-holding within the Arrange window (on the 
Arrange window background, or directly on objects) to begin your selec-
tion. A shaded selection rectangle will appear onscreen as you move the 
mouse. You can drag the selection rectangle freely, allowing you to make 
selections—independent of existing part/object boundaries; when you 
release the mouse, only the area that falls inside the “marquee” is 
selected. In other words, you can use the Marquee tool to make selections 
within existing regions and sequences; your selection is completely 
determined by the selected “marquee” area.
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Within the selected area, you can perform almost all regular Arrange edit 
options, including:

•  Delete (B or click with the eraser tool)

•  Move (drag selection or using a Nudge Key Command)

•  Copy (O-drag) using the Arrow tool

•  Cut/Copy (Cx, Cc)

•  Paste (at SPL, quantized to the nearest bar divisions)

•  Copy/Paste via pencil tool (quantized to current format value)

•  Cut at selection border (click inside the selection with the scissors 
tool)

•  Mute (Key Command or tool; will also result in a cut at the selection 
borders)

•  Solo (Key Command or tool; will also result in a cut at the selection 
borders).

If your selected area falls between musically relevant values, the Mar-
quee tool’s selection rectangle will automatically “snap” to the nearest 
musically relevant position, in accordance with the settings of the new 
“SmartSnap” feature. This facility adjusts the snap resolution according to 
the current zoom setting. If you make your selection while holding C, the 
selection will snap to the finest resolution possible within the chosen 
zoom factor. By holding down S, the current Marquee selection can be 
altered from either the left or right side, as well as up or down.

The new Crop objects outside Marquee Selection Key Command removes 
all unselected areas from objects which are partly selected by the mar-
quee.
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3.5 Time Stretching Regions
Logic 6 allows you to change the length of audio regions (without chang-
ing their pitch) directly in the Arrange window—via menu options or key 
commands.

Adjust Object Length to Locators
Functions > Object > Adjust Object Length to Locators stretches or com-
presses selected audio regions (or MIDI sequences) to fit between the 
current positions of the left and right locators. The object’s start point is 
not changed by this function—so don’t be overly concerned if the Loca-
tors are not precisely above the region or sequence.

Adjust object length to nearest bar
Functions > Object > Adjust object length to nearest bar adjusts the length 
of selected regions to the closest whole bar. This provides an ideal 
method for fitting previously trimmed drum loops into songs where small 
discrepancies between the loop and song tempo exist.

� These two functions use the most recently selected Time Stretching 
Algorithm—set in the Time and Pitch Machine (Sample Editor > 
Factory > Time and Pitch Machine).
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3.6 New Arrange Icons
Logic 6 introduces a new icon format, offering 
high resolution, scalable (from 128 × 128 pixels 
downwards), and user-definable icons. A few of 
the new icons are direct replacements for the 
older Logic icons, but most of the previous icons 
remain in the program to ensure backwards 
compatibility. If you vertically zoom a track with 
new icons sufficiently, you will see the large 
size icon in addition to the small icon at the top.

3.6.1 User-definable Icons
You can create your own icons for Arrange tracks. These Icons must be at 
the size of 128 × 128 pixels, and must be saved in the “portable network 
graphics” format, and must have an alpha channel for transparency. 
Please note that these files must be saved with the “.png” suffix. The file-
name must also start with a three-digit number. If this number is below 
325, the corresponding built-in Logic icon will be replaced by your new 
graphic (you can check the number of existing Logic icons by double-
clicking on them in the Instrument Parameter Box).

In OS 9, user icons must be located inside the Emagic Resources > Icons 
subfolder within your Logic application folder. 

In OS X there are two possible locations for user icons:

The ~/Library/Application Support/Emagic/EmagicResources/Icons 
folder can contain icons which are only valid for the particular user (~ is 
the user name).

If you save your icons in the root directory—/Library/Application Support/
Emagic/EmagicResources/Icons—the icons are valid for all users.

If icons with identical numbers exist in both folders, the icons found in the 
user folder have priority.
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3.6.2 Icon Color
The old, monochromatic icons used to adopt the color of their “parent” 
Audio Object or MIDI Instrument—which is also still used for newly 
recorded Regions/Sequences in the Arrange window.

The new high resolution Arrange Icons have their own color and, therefore, 
can no longer adopt the “parent” object color. To circumvent the overriding 
color of the new icons, Logic 6 incorporates a small color strip on the right-
hand edge of the Track List.

The View > Shadow for Instrument Icons option was removed.
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4 Editor Windows

4.1 Improved Time Machine in the 
Sample Editor

The Time Machine in Logic 6 features four additional algorithms for time 
and pitch modifications. Each of the new algorithms is specialized for cer-
tain types of audio material. All new algorithms deliver the highest preci-
sion possible, to avoid alterations to the length of the audio material.

You can still use the Time Machine as per usual: from within the Factory 
menu of the Sample Editor (see the main Logic manual for instructions).

Audio Type
This new parameter allows you choose between the old and the four new 
algorithms:

•  Version 5 algorithm
this is, obviously, the well-known algorithm of Logic 5 and earlier ver-
sions.
37
Reference Addendum
Version 6



Editor Windows

Logic 6 add en.book  Page 38  Tuesday, March 25, 2003  2:54 AM
•  Any material
This is the most universal algorithm which, theoretically, should be 
able to handle most kinds of material—it is the new “default” setting 
when using the Time Machine. The following algorithms can, however, 
deliver better results in cases where the material exactly matches the 
following criteria:

•  Monophonic
A specialized algorithm for monophonic material, e. g. an individual 
voice, brass or woodwind.

•  Pads
Use this algorithm on polyphonic material with harmonic content, e. g. 
choirs or string sections.

•  Beats
This algorithm perfectly maintains the timing of percussive material. It 
should be your first choice for all kinds of drum loops. It may also be 
useful on staccato, rhythmic piano or guitar parts—i. e. “comping”. 
Experiment with this, if you find that the default algorithm isn’t deliv-
ering the desired results.

4.2 Chord Recognition in the 
Matrix Editor

When selecting multiple notes in the Matrix editor, the information section 
in the upper left corner now displays the chord name of the note combina-
tion being played.
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5 Audio Standard 
Support

5.1 MP3 Support (Mac OS X only)
The Mac OS X version of Logic 6 offers full support for the importing and 
exporting of MP3 files:

5.1.1 MP3 Import
MP3 files may be imported into Logic using the same methods employed 
when adding AIFF, SDII, or WAV files: namely by S-clicking with the pencil 
tool in the Arrange, using the Audio > Add Audio File command, via the 
Audio File local menu of the Audio Window, or by dragging MP3 files from 
the Finder into the Audio Window or Arrange.

When you import MP3 files, Logic converts the MP3 file to an AIFF file, and 
it is the AIFF file that is used in Logic. Logic does this because many func-
tions, such as waveform display, sample accurate editing, and so on, 
would tax the CPU if Logic had to constantly decode and re-encode the 
MP3 files in realtime for each change. By converting the MP3s to AIFF on 
import, Logic ensures the most efficient use of resources.

5.1.2 MP3 Export
Logic can export MP3 files as well, using technology Apple licensed from 
the Fraunhofer Institute, the developers of the MP3 format. You can select 
MP3 as a file format for Bouncing, or by using the “Convert to MP3” com-
mand in the Audio File local menu of the Audio Window.
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Bouncing MP3 Files
“MP3” is now one of the options in the pull-down File Format menu of the 
Bounce dialog. When you select MP3 as your file format, the bounce 
options for Resolution, Stereo File Type, Surround Bounce and Dithering 
are replaced by the “MP3 Export Settings” listed below. You can choose to 
Bounce MP3 files in realtime, or offline.

Convert To MP3
MP3 files can also be created from individual audio files by using the 
“Convert To MP3” command of the Audio File local menu in the Audio Win-
dow. When you create an MP3 file via this command, the encoder uses the 
Global settings of the MP3 Export Preference dialog, found in the Logic 
menu.

MP3 Export Settings
Below are the MP3 Export settings found in the Logic > Preferences > 
MP3 Export menu, along with some usage tips.

Bit Rate (Mono/Stereo)
The bit rates are selectable between 8kbps and 320kbps, but default to 
80kbps mono, and 160kbps stereo. These rates offer acceptable quality 
and good file compression. If you can afford the extra file size, we recom-
mend 96kbps for mono, and 192kbps for stereo streams, as this provides 
better audio quality. You can, of course, choose even higher rates, but the 
quality improvement in bit rates above 96/192kbps is minimal.
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Quality
Keep this set to Highest whenever possible. Reducing the quality will 
speed up the conversion process, but at the expense of audio quality.

Use Variable Bit Rate Encoding (VBR)
Variable Bit Rate encoding compresses “simple” passages more heavily 
than harmonically-rich passages, generally resulting in better quality 
MP3s. Unfortunately, not all MP3 players can accurately decode VBR-
encoded MP3s, which is why this option is turned off by default. If you 
determine that the listener/s of your MP3 can decode VBR-encoded 
MP3s, you can switch this option on.

Use Best Encoding
Again, like the Quality parameter, you will gain encoding speed at the 
price of audio quality if this option is unchecked. This should always be 
left on, unless conversion time is an issue.

Filter Frequencies Below 10Hz
When this option is checked, frequencies below 10Hz (which are usually 
not reproduced by speakers, and are not audible to human ears, at any 
rate…) will be removed, leaving slightly more data bandwidth for the fre-
quencies which we can hear, resulting in an improvement in perceived 
quality. Only uncheck this if you’re experimenting with subsonic test 
tones, or exporting MP3s for whales …

Stereo Mode
You can select joint stereo or normal stereo mode. Depending on the orig-
inal file, these settings may (or may not) offer any audible difference. 
Experiment with both settings to determine your preference.
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6 Project Manager

File > Save as project...
This global command internally uses the Project Manager’s database. Use 
it to Save a Song with all, or specific data types (audio files, EXS instru-
ments, samples, movie files), into a new folder—i. e. the “Project Folder”. 
This is useful for backing up a production, transferring a song to another 
studio, or simply to organize your hard disk(s) more efficiently …

Use of this command will launch the “Consolidate Song Functions” dialog 
window, where you can enter a “Project Folder Name” and choose from 
several options (mainly regarding choices to copy, move or simply leave 
certain file types at their current location(s)).
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